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Introduction11
This  document describes  the  recommended  supported  work-flows  for  the  LabTutor
Teaching Suite and addresses frequent issues and questions, including:

System and infrastructure requirements and recommendations

Networking setup and connection troubleshooting

Data backup and disaster recovery

Course administration

Common student issues

LabTutor Online setup and configuration

Frequently asked questions (FAQ)

Using This Document
This  document  should  be  consulted  by  any  users  installing,  configuring  or
administering  the  LabTutor  Teaching  Suite.  Although  this  document  makes  good
reference material at any time, it  is  designed to  be  of  best use  when considering what
IT infrastructure  is  required to  run LabTutor Suite,  how the  course  will  be  run  using
LabTutor Suite, and how it will be administered on an ongoing basis. 

The aim of this document is  to  maximize  the  likelihood of a  LabTutor course  running
smoothly and help provide a better user experience.

What is LabTutor Suite?
LabTutor  Suite  is  a  set  of  software  products  developed  by  ADInstruments  that
provides  a  complete  solution for a  ‘paperless’  and efficient means of  running  tertiary
life-science laboratory sessions. 

LabTutor Suite consists of the following products:

1. LabTutor  Server  -  Provides  a  centralized  way  to  access  experiments  and
administer  courses.  The  web-based  administration  interface  for  the
LabTutor  Suite  allows  you  to  easily  manage  multiple  courses  and  student
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information  from  any  computer  within  your  local  network.  All  student
experiment data is stored on LabTutor Server for easy access.

2. LabTutor  Online  -  An  internet-based  service  that  provides  the  ability  for
students  to  view  their  experimental  data  and  to  complete  and  submit
experiment reports. This is can be done from any device  that has  an internet
connection  and  a  web  browser  that  supports  Flash  or  HTML5.  LabTutor
Online  also  allows administrators  to  review students’  experiments  over  the
Internet.

3. LabTutor Client -  Displays  the  LabTutor  Experiments  from  the  LabTutor
Server.  LabTutor  Client  silently  handles  communication  with  LabTutor
Server and the  PowerLab, and should be  installed on each computer  in  the
student laboratory. LabTutor experiments contain all instructions needed by
students, as well as interactive components that sample  and display real data
from a PowerLab.

4. LabAuthor -  A  tool  for  customizing  or  creating  LabTutor  experiments  for
your courses. LabAuthor can be  used on a  stand-alone  computer that need
not be connected to LabTutor Server or the  network. Once  you are  finished
creating or editing an experiment it  can be  exported from LabAuthor as  an
experiment installer, and installed to LabTutor Server.
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The focus of the LabTutor Teaching Suite is split into two areas:

Classroom  -  Experiments  are  performed  through  a  web  browser  on  a
computer running the  LabTutor Client software. Experimental data  is  saved
to LabTutor Server via the local network.

Outside  Institution  Network  -  Experiments  from  the  LabTutor  Server  are
transferred  via  the  Internet  to  LabTutor  Online.  With  LabTutor  Online
students  can  log  on  from  anywhere  with  an  internet  connection  to  view
experiments, analyze data, view media content and complete reports.
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Upgrading from LabTutor 3
In contrast to LabTutor 3, LabTutor 4 has adopted a client-server model that facilitates
centralized  management  of  student  data  (LabTutor  Server).  LabTutor  Online  is  a
component  that  allows  students  to  remotely  access  their  experiments  over  the
Internet.

In  LabTutor  3,  experiments  were  required  to  be  installed  on  each  computer
individually, and student data  removed at the  end of each lab  session. In LabTutor 4,
experiments  are  installed to  the  LabTutor Server and accessed from client computers
over  a  network  using  Microsoft  Internet  Explorer.  LabTutor  Server  provides  a
centralized place  to  administer  laboratory  courses.  Each  Student  has  their  own  login
and can work independently of other students or in a group.

How to upgrade
Before  upgrading  to  LabTutor  4,  all  LabTutor  version  3  experiments  should  be
backed-up  onto  an  external  drive  or  media,  and  all  associated  LabTutor  3  software
uninstalled. LabTutor 3 and 4 cannot operate concurrently.

How to convert your LabTutor 3 experiments to LabTutor 4
All ADInstruments  LabTutor 3  experiments  are  available  in  LabTutor  4  format  and
can be  installed from Install  Media  or  ADInstruments  Website  using  the  LabTutor
Server administration pages.
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Custom Experiments  created in earlier  versions of  LabAuthor may  still  be  used  with
your  upgraded  LabTutor  Server,  however  a  few  important  things  to  take  into
consideration:

For your experiment installer to be able to be installed and give rise to a
functional experiment on LabTutor Server, it must be saved in the same
version of LabAuthor as LabTutor Server. i.e. It is best practice to upgrade
LabAuthor at the same time as upgrading LabTutor Server, with the same
version.

To re-save an experiment installer created in an earlier version of LabAuthor:

1. Double-click on the out-dated experiment installer and install the
contained experiment files locally.

2. Open the experiment (.adiexp) file with the upgraded version of
LabAuthor

3. Re-save the experiment File > Save Experiment As...

4. Re-save the experiment installer File > Save Experiment Installer...

5. The experiment installer may now be uploaded and installed to LabTutor
Server
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System
Configuration22

While  LabTutor  Server  can  be  installed  on  just  about  any  modern  computer,  it  is 
important  to  make  sure  that  the  computer  you  select  to  install  LabTutor  Server  is 
sufficiently equipped to run your LabTutor Teaching Lab. It is recommended that you 
run the LabTutor Installation Advisor (adinstruments.com/LabTutor-Server-Advisor) 
on the prospective LabTutor Server computer before you install and configure the 
software. In general your LabTutor Server computer needs to meet the system 
requirements. In addition, you should consider installing an uninterruptible power 
supply (UPS) on the server to protect data from power outages, implementing a reliable 
backup scheme and physically locating the server in a secure location. The LabTutor 
Server should be kept running at all times, where possible.

The best practice for LabTutor Server is to  install it  on a  dedicated server. There  are  a
number of reasons why this is the recommended option:

Having  a  dedicated  server  avoids  software  conflicts  with  other  web  server
applications.

Performance  of  the  LabTutor  Server  will  be  better  as  it  does  not  have  to
share  resources  with  other  services,  providing  the  best  overall  user
experience. 

It is easier to backup and recover in the event of a disaster.

LabTutor  Server  needs  to  be  installed  on  a  computer  that  allows  for  a  web-based
application  to  operate.  LabTutor  Server  cannot  be  installed  on  a  computer  that  is
currently  providing  services  on  port  80  and/or  443  (e.g.  it  has  Internet  Information
Services  (IIS)  or  Apache  installed).  It  is  also  recommend  that  the  LabTutor  Server
computer be  assigned a  static IP address, and not a  dynamic  one,  and  should  ideally
have a Domain Name System (DNS) for it (e.g. labtutor.university.com).

It is  important to  note  that when using LabTutor  Online,  large  amounts  of  outgoing
data  will  be  sent  from  LabTutor  Server  to  LabTutor  Online.  Because  of  this,  it  is
recommended  that  your  LabTutor  Server  has  an  Internet  connection  with  a  good
upload  speed  to  avoid  delays  in  transferring  student  data  from  LabTutor  Server  to
LabTutor Online.

http://www.adinstruments.com/LabTutor-Server-Advisor
http://www.adinstruments.com/LabTutor-Server-Advisor
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Hardware and Software Requirements

Key Information

Use a dedicated computer for LabTutor Server, if possible

Run  LabTutor  Server  Installation  Advisor  to  see  if  your  server  meets
minimum requirements

Particular care needs to be taken if  using a  virtual machine  for your server -
use enterprise solutions such as Hyper-V or ESXi

Don't install LabAuthor in the same machine as LabTutor Server

To provide your users with the best LabTutor experience  it  is  important to  make  sure
that  LabTutor  and  LabTutor  Client  machines  are  adequately  equipped  to  run  your
teaching  course.  Failing  to  have  adequate  hardware  for  either  the  client  or  server
machines could result in a  poor  user  experience,  so  getting  it  right  from  the  start  is
critical.

LabTutor Server is at the heart of the  LabTutor Suite  and it is  therefore  pertinent that 
the right choices be made  regarding the  server's  hardware, configuration and location. 
While  LabTutor  Server  can  be  installed  on  just  about  any  modern  computer,  it  is 
important  to  make  sure  that  the  computer  you  select  to  install  LabTutor  Server  is 
adequately equipped to  run your  LabTutor  Teaching  Lab.  The  system  requirements 
for LabTutor Server can vary greatly depending  on  the  number  of  PowerLabs  being 
used  and  the  number  of  students  that  will  be  using  LabTutor  per  semester. 
ADInstruments provides a small utility called the LabTutor Server Installation Advisor, 
which  can  be  run  on  a  prospective  server  computer  to  determine  if  it  meets  the 
recommended  system  requirements  for  running  LabTutor  Server  in  a  particular 
environment. The LabTutor Server Installation Advisor can be downloaded from 
adinstruments.com/LabTutor-Server-Advisor.

LabTutor Server Installation Advisor
The  LabTutor  Server  Installation  Advisor  is  a  stand-alone  application  that  checks
hardware,  software  and  network  requirements.  The  utility  will  function  on  any
supported  Microsoft  Windows  operating  system  and  will  test  the  chosen  system  in
order to determine if it is suitable to be used as a LabTutor Server. 

The  installation advisor's  main screen allows you to  select  the  number  of  PowerLabs
that will be used, and the number of students that will use LabTutor per semester.

http://www.adinstruments.com/LabTutor-Server-Advisor
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The Installation Advisor will then analyze the system:

The  results  of  the  analyses  are  then displayed, with any issues  highlighted by either  a
red  cross  for  a  fail,  or  a  yellow  exclamation  mark  for  a  warning.  Any  fail  messages
should be addressed before installing LabTutor Server.
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LabTutor Server

The general software requirements for LabTutor Server are as follows:

Microsoft Windows 7 or Windows Server 2008/2008 R2 recommended, 
Windows Vista SP1, or Windows Server 2003/2003 R2 supported

Microsoft .NET v2.0 Service Pack 2 or v3.5 Service Pack 1 required

Internet Explorer 9 recommended, IE 7 minimum

LabTutor Server requires exclusive the use of ports 80, 443 and 8005; other web
server products cannot be installed

Direct Internet access is required for LabTutor Online and for access to  
ADInstruments.com for software updates and experiment installation

Adobe  Reader 8.0 or later  is  required to  view  all  language  experiment  report
PDFs.  Adobe  Reader  X  or  later  is  required  to  annotate  experiment  report
PDFs. The latest version of Adobe Reader is recommended.

http://adinstruments.com
http://adinstruments.com
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The  actual hardware  requirements  for LabTutor Server will be  somewhat  dependent
on  your  needs.  ADInstruments  always  recommends  running  LabTutor  Server
Installation Advisor on the server prior to installing LabTutor Server. If you are looking
at buying a  new computer to  run LabTutor Server on please  see  the  example  system
recommendations below for an idea of what specifications your server should have. 

When buying or building a computer for LabTutor  Server  you  should  consider  the
following:

A full size computer case with good airflow and a full size ATX motherboard

A quad core CPU over a dual core CPU if possible 

8GB  (or  more)  of  RAM.  RAM  is  relatively  cheap  and  will  help  with
performance of the system

Two good-sized hard disks in RAID-1. This  will provide  some  protection from
drive failures

A good quality power supply (PSU)

Install a 64-bit Operating System

Have the server on an uninterruptible power supply (UPS)

The following is a list of general considerations for LabTutor Server:

Where  possible  have  a  dedicated  LabTutor  Server  machine.  By  having  a
dedicated server you will avoid conflicts  with other software, and  you  will  get
the best overall performance from the system.

Locate the server machine in a physically secure location; restrict access.

Have  a  reliable  backup scheme  in place  so  that  your  LabTutor  Server  data  is
regularly backed up in case of a disaster.

Leave  the  LabTutor  Server  computer  running  around-the-clock,  especially  if
you are using LabTutor Online.

If  you are  using LabTutor Online  ensure  that  your  Internet  connection  has  a
sufficient upload speed. LabTutor Server can transfer large  amount of  data  to
LabTutor  Online,  and  having  a  good  upload  speed  will  help  avoid  delays  in
transferring this data.

The following are some examples of recommend hardware configurations:

1 - 10 PowerLabs with 100-500 students per semester:

Quad Core CPU recommended, Dual Core minimum

2GB RAM recommended, 1GB minimum
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600GB free hard drive space recommended, 200GB minimum

1Gbps wired network connection recommended, 100Mbps minimum

11 - 30 PowerLabs with  500-2000 students per semester:

Quad Core CPU recommended, Dual Core minimum

4GB RAM recommended, 2GB minimum

1.5TB free hard drive space recommended, 500GB minimum

1Gbps wired network connection recommended, 100Mbps minimum

31 - 60 PowerLabs with >2000 students per semester:

Quad Core CPU recommended

6GB RAM recommended, 2GB minimum

2TB free hard drive space recommended, 750GB minimum

1Gbps wired network connection recommended, 100Mbps minimum

LabTutor Client

The  following  are  the  general  hardware  and  software  requirements  for  LabTutor
Client:

Microsoft Windows 7 or later, or Windows Vista SP1 or later supported

Microsoft .NET v2.0 Service Pack 2 or v3.5 Service Pack 1 required

Internet Explorer 9 recommended, IE 7 minimum

Dual Core CPU recommended

2 GB RAM recommended, 1GB minimum

1Gbps network connection to LabTutor Server recommended, 100Mbps 

minimum

10 GB free hard drive space

Flash Player plug-in for Internet Explorer 9.0.115 or later is required to play 

video and audio

LabAuthor

The following are the general hardware and software requirements for LabAuthor:

Microsoft Windows 7 or later, or Windows Vista SP1 or later supported
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Microsoft .NET v2.0 Service Pack 2 or v3.5 Service Pack 1 required

Internet Explorer 9 recommended, IE 7 minimum

Dual Core CPU recommended

2 GB RAM recommended, minimum

50 GB free hard drive space 

Flash Player plug-in for  Internet  Explorer  9.0.115  or  later  is  required  to  play
video and audio

Please note that installing LabAuthor on the same computer as  LabTutor Server is  not
a  supported  configuration.  LabAuthor  and  LabTutor  Server  share  common
components  and having both installed on the  same  machine  could  lead  to  confusing
and unpredictable behavior.

Virtual Machines

LabTutor Server and Virtual Machines

LabTutor Server can work very well in enterprise-class  virtual environments  and there
are no known compatibility issues  with running LabTutor Server in a  virtual machine.
However,  ADInstruments  recommends  using  native  installs  where  possible  to
maximize performance. 

Due  to  the  rich  and  engaging  content  provided,  LabTutor  Server  can  be  resource
demanding -  it  may stream high-quality videos to  many  clients  and  has  to  do  CPU-
intensive  file  conversions  when  uploading  student  data  to  LabTutor  Online.  With  a
whole lab of  students  recording or viewing data, disk space  access  and network access
must be reliable. 

If  you  wish  to  install  LabTutor  Server  on  a  virtual  machine  it  is  advised  not  to  use
'desktop' virtualization software such as  VMware  Fusion or Workstation, Sun's  Virtual
Box, or Parallel's Desktop. Server-orientated virtualization platforms such as VMware's
ESXi,  Citrix's  XenServer  or  Microsoft’s  Hyper-V  are  more  suitable.  Ideally  the
LabTutor Server virtual machine  should be  given its  own large  dedicated physical disk
or RAID array, have high-priority access to CPU resources, enough dedicated RAM (as
recommended by the  LabTutor Installation Advisor) and a  dedicated  network  to  the
storage  host (important if  virtual  machine  data  is  stored  on  a  storage  area  network,
SAN).

LabTutor Server can be installed on an Intel-based Macintosh computer running Boot
Camp provided it meets the minimum system requirements.

LabTutor Client and Virtual Machines
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LabTutor Client and LabAuthor require  Microsoft Windows and Internet Explorer to
operate. If your teaching labs are equipped with Intel-based Macintosh computers, you
can use the LabTutor Teaching Suite by using Internet Explorer on Microsoft Windows
in Boot Camp.

Virtual machine  software  such as  Parallel's  Desktop for Mac or VMware  Fusion  may
be  used,  however  for  best  performance  and  reliability,  ADInstruments  recommend
and  support  LabTutor  use  with  Boot  Camp  only.  Virtual  machines  should  only  be
used  if  you  require  access  to  Macintosh  applications  and  need  the  ability  to  switch
between Mac and Windows operating systems during the  class.  While  using LabTutor
Client in a virtual machine should work, it is important to note that it  is  not currently a
supported configuration.

LabTutor Client and thin-client Workstations

LabTutor Client may work on thin-client setups, however this  depends very much on
your  particular  setup  and  there  is  no  easy  one-size-fits-all  answer  as  to  how  it  will
perform. Thin-clients are great for running applications like  Microsoft Word, checking
email,  browsing the  Internet etc,  but  are  not  ideal  for  things  that  involve  heavy  disk
usage (due to contention - all the clients will likely be accessing the same  storage  array),
or heavy network usage. 

For example, if  the  students  watch a  video  in a  LabTutor Experiment then that video
probably  has  to  be  streamed  from  LabTutor  Server  to  each  of  the  virtual  desktops
running  under  the  virtual  host,  and  from  there,  to  each  of  the  client  machines.
Depending on the  setup, this  could be  a  problematic bottleneck, although some  thin-
client  solutions  have  been  getting  much  better  at  handling  this.  Another  potential
confounder is the high-rate sampling used in some experiments.

In these  sorts  of  situations ADInstruments  recommends  that  you  do  a  small  trial  of
running LabTutor in this setup, which should give some indication of what your system
can cope with, and what it can't. For example, having a  few of the  classroom machines
access the videos in one of the  experiments  would likely give  a  very good indication of
how things will run.

It's  recommended  that  you  get  in  contact  with  your  ADInstruments  representative
with some information about your setup so further advice can be given.
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Network

Key Information

Use 1Gbps network where possible

Avoid wireless networks

LabTutor Server needs direct Internet access - no proxy servers

LabTutor Server requires use of ports 80, 443 & 8005 on the server

Run Net Checker utility to help diagnose connection issues

LabTutor 4 has  been designed to  work in a  networked environment where  there  is  a
central  server  that  has  LabTutor  Server  installed,  clients  in  a  laboratory  that  have
LabTutor  Client  installed  and  content  able  to  be  accessed  outside  of  the  campus
though LabTutor Online.

The  LabTutor  4  Suite  requires  that  all  computers  (clients  and  server)  be  connected
together  via  a  Local  Area  Network  (LAN).  Before  installing  LabTutor  Server  and
LabTutor Client you should verify that clients can connect to the  server computer over
the  network. Depending on how your network  is  managed,  you  may  be  required  to
consult with your IT department before deploying the LabTutor 4 Suite. 

The LabTutor Server Installation Advisor utility assists in making sure  that the  server's
network connection is suitable. ADInstruments recommends the use  of  a  1Gbps wired
network for LabTutor Suite  as  this  will provide  users  with the  best overall experience
and  performance.  For  optimal  performance,  clients  should  have  the  same  network
connectivity speed as  the  server.  i.e.  if  LabTutor  Installation  Advisor  recommends  a
1Gbps  network  speed  for  the  server,  then  if  possible,  the  clients  should  all  have  a
1Gbps connection back to the server. 

Having  an  inadequate  network  setup  could  result  in  a  poor  user  experience,  so
attaining  recommended  specifications  is  critical  for  reliably  running  a  successful
LabTutor 4 course.

LabTutor Client  machines  do  not  require  access  to  the  Internet,  however  LabTutor
Server  requires  a  direct  connection  to  the  Internet  to  obtain  software  updates  and
experiments installers, as well as to connect to LabTutor Online.

Wireless Networks

For  performance  and  reliability  reasons  ADInstruments  does  not  recommend  or
support  the  use  of  wireless  networks  with  LabTutor  Suite.  There  are  a  number  of
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reasons for this:

Wireless  performance  can  have  negative  effects  on  how  LabTutor  performs.
Since LabTutor Client stores all data  on LabTutor Server there  is  the  potential
for  large  amounts  of  data  needing  to  be  transferred  over  the  network.  In  a
busy LabTutor environment with many client machines and students, wireless
can struggle to deliver data in sufficient speed.

The reliability of wireless networks is often not as good as a wired network.

The type of wireless technology being used can have a dramatic effect on how a
wireless network performs.

The  number of  clients  that use  the  same  wireless  access  point  has  a  dramatic
effect on how a wireless network will perform.

Where possible you should use a wired network as this will provide users  with the  best
overall  LabTutor  experience.  There  are  too  many  variables  that  can  have  negative
effects on wireless performance and reliability.

Internet Access and Proxy Servers

LabTutor Client  machines  do  not  require  access  to  the  Internet,  however  LabTutor
Server  requires  a  direct  connection  to  the  Internet  to  obtain  software  updates  and
experiment installers, as well as to connect to LabTutor Online. 

For  technical  reasons  LabTutor  Server  does  not  support  the  use  of  proxy  servers
(either  authenticated  or  unauthenticated).  A  direct  connection  to  the  Internet  is
required  for  accessing  LabTutor  Online  and  the  ADInstruments  website.  If  your
network uses  a  proxy server for  access  to  the  Internet,  an  exception  will  need  to  be
added  so  that  LabTutor  Server  can  directly  access  the  Internet  on  port  80  and  443.
LabTutor Server will fail to  connect to  LabTutor Online  and fail to  download updates
and experiment installers if a direct connection to the Internet is unavailable.

Net  Checker  can  be  run  on  the  LabTutor  Server  machine  to  ensure  that  a  direct
connection to the internet is available (see below)

If  machines running LabTutor Client are  setup to  access  the  Internet though  a  proxy
server  then  an  exception  should  be  added  so  that  they  directly  access  content  on
LabTutor Server. On a local network there  is  usually no  reason to  for clients  to  access
local content though a proxy server.

Net Checker
Net Checker is  a  small utility  that  can  be  run  on  a  LabTutor  Server,  providing  clear
feedback regarding your current network configuration. It checks that LabTutor Server
is able to communicate with LabTutor Online and the ADInstruments web page. If Net

http://cdn.adinstruments.com/Installers/win/LTSNetChecker_v1.0.1.exe
http://cdn.adinstruments.com/Installers/win/LTSNetChecker_v1.0.1.exe
http://cdn.adinstruments.com/Installers/win/LTSNetChecker_v1.0.1.exe
http://cdn.adinstruments.com/Installers/win/LTSNetChecker_v1.0.1.exe
http://www.adinstruments.com


20 LabTutor Teaching Suite Best Practice Guide

Checker returns a failed result, you will likely have  to  consult with your IT department
and rectify your network settings.

Net Checker is installed with LabTutor Server and is available from the ADInstruments 
program group in the Start menu. It is also available to download from 
ADInstruments.com.

Checking Network Connection

Before installing LabTutor Server and LabTutor Client you should verify that the  client
computers  can communicate  with the  server computer over the  network.  Depending
on how your institution's network is setup you may be required to consult with your IT
department before deploying LabTutor 4 Suite.

If you are having issues with clients communicating with the LabTutor Server there  are
a few things that you can do to troubleshoot the issue. These include:

Pinging the server

Checking the network cable and connections from the  client computer to  the
server computer.

Ensuring that the  correct IP addresses  are  assigned  to  the  client  and  server
machines, and that they are on the same subnet mask. 

Cables and IP Addresses
If  you  are  having  problems  with  one  particular  client  machine  connecting  to  the
LabTutor Server, the  issue  is  likely to  be  a  physical network connection issue  or an IP
Address configuration issue on the client in question. You should:

Check that the network cable is correctly connected.

Verify that the wall plug is patched into the network.

Check the network cable for physical damage.

Verify that the client has a valid IP address for your network -  you may need
consult your IT department for further help with this.

Required Ports

LabTutor Server requires exclusive use of ports 80, 443 and 8005 on the server where  it
is  installed. Ports  80 and 443 are  used by clients  and administrators  to  connect  to  the
LabTutor Server and access  experiments  and administration pages. Port  8005  is  used
internally by the Apache Tomcat process to communicate with itself. The ports used by
LabTutor Server cannot be changed or configured. If  you have  other software  causing
a  port  conflict,  that  software  must  be  altered  or  removed  for  LabTutor  Server  to
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function correctly.

The LabTutor Server installer program will warn you if  it  detects  that there  is  another
application utilizing port 80, 443 or 8005 before  installing the  software. This  is  however
just a  warning and LabTutor Server  can  still  be  installed.  However,  LabTutor  Server
will  not  function  until  the  required  ports  become  available.  Typically  if  this  is  a
departmental server the  most likely reason port 80 and 443 are  in use  is  because  this
computer has a web server installed on it, such as IIS or Apache. In this  case  you either
need to uninstall the conflicting product from the server, or install LabTutor Server on
a different machine. The  LabTutor  Installation  Advisor  can  also  be  used  on  existing
servers to detect this. 

Firewalls

When LabTutor Server is  installed, the  installer  automatically adds the  required rules
to  the  Windows  Firewall  to  allow  LabTutor  Server  to  communicate  with  clients  on
ports 80 and 443. If clients are having issues connecting to the  server check that firewall
exceptions  are  still  in  place  in  the  Windows  Firewall  control  panel  item.  If  the
LabTutor Server exception is missing, and there are no other exceptions to  allow ports
80 and 443 through the  firewall,  then you will need to  manually add this  exception to
the firewall. If  your server is  running a  firewall other than the  Windows Firewall  you
may need to manually add exceptions for LabTutor Server on ports 80 and 443.

Remember that LabTutor Server needs a direct connection to the Internet to 
communicate with LabTutor Online and ADInstruments.com. Net Checker can be run 
on the LabTutor Server machine to ensure that a direct connection to the Internet is 
available (see the 'Net Checker' section for more information).

Antivirus Products

Many antivirus products  can interfere  with the  normal operation and performance  of
LabTutor  Server  and  LabTutor  Client.  This  is  because  many  antivirus  products
perform realtime scanning of web page content. Because LabTutor content is all served
over HTTP this realtime scanning can add significant overhead to  page  load times, and
in  some  cases,  prevent  LabTutor  from  functioning.  If  you  experience  performance
issues  with  LabTutor  it  is  recommended  that  you  disable  any  realtime  antivirus
software  scanning  for  HTTP,  and  that  any  antivirus  Internet  Explorer  add-ons  are
disabled.

Incompatible Software
If you have Skype installed on the same  machine  as  LabTutor Server, this  can result in
ports 80 and 443 being used by Skype, and therefore  not being available  for LabTutor
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Server. You can get around this  by  disabling  Skype  from  using  ports  80  and  443  for
incoming  connections.  Go  into  Skype  and  click  Tools  >  Options  >  Advanced  >
Connection and uncheck the  box  that  says  Use  port  80  and  443  as  alternatives  for
incoming connections.  VMware  Server  also  has  the  same  issues,  and  should  not  be
installed on the same machine as LabTutor Server.

Multiple Sites

If you have multiple locations which need to access  LabTutor Server, the  ideal solution
is to have a LabTutor Server hosted at each location, however, there  may be  situations
where this is not practical or possible. If you must have  one  centrally-hosted LabTutor
Server then you need to  ensure  that the  networks connecting the  remote  locations to
this  central  location  are  adequate  -  have  a  fast  and  reliable  connection.  Ideally  this
connection should be 1Gbps, however this may not be attainable.

If  you require  your LabTutor Server to  be  accessed from  multiple  locations,  you  will
need  to  get  specific  details  of  the  network  connection  (such  as  link  speed,  latency,
contention levels and if there are link backups in case of primary link failure) from your
IT department and contact your ADInstruments representative for further advice.

Backups and Disaster Recovery

Key Information

Backups are your responsibility

Setup database snapshots to run before backups occur

Keep multiple copies of backups in case a backup becomes corrupt

Have on-site and off-site backups

Have a written disaster recovery plan in a sensible place

All LabTutor Server data is stored in the LabTutor Server data folder

It is extremely import that you backup LabTutor Server data  so  that in the  event of  a
disaster LabTutor Server can be restored with minimal loss  of  data   remember all of
your user’s  data  is  stored on the  LabTutor Server machine. ADInstruments  does  not
provide  a  solution for backing up LabTutor Server Data; it  is  the  responsibility of  the
customer  to  maintain  backups  for  their  server.  Failure  to  maintain  correct  backups
could result in the loss of data in the event of a disaster.

In order to  have  a  full backup of your LabTutor Server data  you need to  ensure  that
you have made a recent snapshot of your LabTutor Server database, and that you have
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a full copy of  the  LabTutor Server  data  directory.  The  combination  of  both  backups
and snapshots will provide  you with an easy way to  restore  server or move  LabTutor
Server data.

Snapshots  ensure  that  all  necessary  parts  of  the  database  are  correctly  stored  for  a
backup to occur, but are not a full backup themselves. Both snapshots  and backups are
required for restoring a database and should therefore be performed daily.

Snapshots

What is a Database Snapshot?
LabTutor  Server  uses  a  private  (internal)  database  to  store  all  information  about
students  and experiments. This  internal database  cannot  be  reliably  backed  up  while
LabTutor Server is  running. To provide  copies  of  your database  which can be  backed
up, LabTutor Server makes daily snapshots  containing everything in  its  database  and
saves these in the  LabTutor Server data  folder. These  snapshots  can then be  included
as part  of  your  regular  backup.  Snapshots  are  generated  automatically  by  LabTutor
Server. Once you have set up a  time  for snapshots  to  be  created in the  administration
pages, they will occur at the set time every day.

Database Snapshots are configured in the Server > Configuration Tab of the  LabTutor
Server administration pages. You can also  perform a  snapshot  manually  by  choosing
the  Snapshot  Now  option  within  the  Configuration  tab  of  the  LabTutor  Server
administration pages.

Backups

What needs to be backed up?

LabTutor Server stores  its  data  in a  folder in the  ADInstruments  area  of  the  (hidden)
Program  Data  or  Application  Data  folder.  This  folder  contains  all  data  stored  by
LabTutor  Server.  The  entire  data  folder  must  be  included  as  part  of  your  backup
procedure.  Database  snapshots  alone  do  not  provide  a  backup  of  LabTutor  Server
data. To backup LabTutor Server, a  recent database  snapshot is  required as  well as  a
full backup of the LabTutor Server data folder.

The path to the data folder depends on the version of Windows you are running:

Server 2003: C:\Documents and Settings\All Users\Application 
Data\ADInstruments\LabTutor Server

Windows Vista and later: C:\ProgramData\ADInstruments\LabTutor Server
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How often should I create a backup?
All LabTutor Server data  should be  backed up daily. It is  strongly recommended that
you  configure  your  backup  software  to  keep  at  least  one  weeks  worth  of  previous
backups available in case more than a single day of changes need to be rolled back.

You  should  implement  a  backup  strategy  to  ensure  that  a  frequent  copy  of  the
LabTutor Server data  is  placed into  secure  locations; ideally this  should be  done  on  a
daily basis.  This  strategy  should  include  the  data  being  stored  in  an  easily  accessible
location on-site, so it can quickly be restored if the need arises. 

You should also  ensure  an off-site  backup  is  also  taken  at  frequent  intervals.
Again, this  should be  fairly easily  accessible  in  the  event  you  need  to  restore
from this backup.

Ideally more  than one  previous version should be  available  both  on  and  off-
site;  you don't want to risk overwriting a good backup with a corrupt one.

Do not store backups on the computer running LabTutor Server because  your
backups may be lost if the computer fails.

ADInstruments  does not provide  or recommend any  backup  solutions  for  LabTutor
Server. It is your responsibility to configure, maintain and verify that your backups are
working as intended.

When to perform Database Snapshots and Data Backups?
Daily backups  and  snapshots  should  be  scheduled  to  run  overnight  when  LabTutor
Server is  not in use, to  avoid affecting students. The  performance  of  LabTutor Server
will  be  reduced  while  these  operations  are  in  progress.  The  backup  should  be
configured to run two hours after the daily database snapshot. The exact time  required
to  create  a  snapshot depends on the  size  of  the  database  and speed of  the  computer,
however, in most cases  the  actual time  required will be  less  than five  minutes.  A  two
hour  delay  should  still  be  used  to  ensure  the  snapshot  completes  before  the  daily
backup.

Does LabTutor Server support Volume Shadow Copy?
LabTutor Server does not support the  use  of  Volume Shadow Copy (VSS). You need
to use the Database Snapshot feature to ensure the database is backed up reliably.

Using Snapshots and Backups

With backups and snapshots, restoring or relocating LabTutor Server is easy. 

Restoring a Backup
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If  you need to  restore  the  LabTutor Server data  to  an older version, you  must  firstly
stop the  LabTutor Server service  using  the  Service  Controller  in  the  ADInstruments
folder in  the  Start  Menu.  Then  replace  the  LabTutor  Server  folder  with  the  backup
copy before restarting the service. 

It is important to ensure that the  version of LabTutor Server that is  currently installed
matches  the  version  that  was  installed  when  the  backup  was  taken.  The  LabTutor
Server service may take up to five minutes to start due to the restoration process.

For the location of the LabTutor Server data folder see the 'Backups' section.

How do I move LabTutor Server to another computer?
Moving LabTutor Server data  to  a  new computer follows  much  the  same  process  as
restoring a  backup. Once  LabTutor Server is  installed  on  the  replacement  computer,
stop  the  LabTutor  Server  service,  replace  the  LabTutor  Server  data  folder  with  the
backed up one and restart the service. 

It is important to ensure that the  version of LabTutor Server that is  currently installed
on the replacement computer matches the  version that was installed when the  backup
was taken. 

Once the LabTutor service has started and you can access the administration pages you
should take  a  database  snapshot. It will also  be  important to  update  DNS  records  so
that they point to the server's new IP Address (if it has changed).

For the location of the LabTutor Server data folder see the Backups' section.

Disaster Recovery

In the  unfortunate  event that a  computer running LabTutor Server fails  in some  way
and is not immediately recoverable, it is a priority to ensure  that students  can continue
to use LabTutor with minimal disruption.

Ensure  that  you  have  a  written  plan  for  a  disaster  recovery  scenario  that  has  been
discussed  with  other  staff  and  stakeholders.  An  A3  PDF  template  is  installed  with
LabTutor  Server  and  available  from  the  Start  menu:  ADInstruments  >  LabTutor
Server > Backup and Recovery. Digital and printed versions of this should be  filled out
with  information  specific  to  your  LabTutor  set-up,  and  kept  in  an  easily  accessible
location.

In the event of a disaster (e.g. a complete failure of the  LabTutor Server computer) the
best option is to have a standby computer that is  ready to  take  on the  workload of the
failed LabTutor Server computer.

Obtain  a  similar  computer  to  act  as  a  substitute  for  your  primary
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LabTutor Server
Ideally this would be a physical computer, however as  a  short-term solution,
a Virtual Machine may be used.

The  hardware  and software  specifications should be  as  close  to  the  primary
LabTutor Server as possible. However, it is understandable  that this  machine
may  be  of  a  lower  specification,  so  use  the  LabTutor  Server  Installation
Advisor  to  check  how  it  matches  the  recommended  requirements  for  a
LabTutor Server computer.

If  the  computer is  of  lower specification, you should evaluate  the  effect  this
will  have  on  your  laboratory  and  make  any  necessary  preparations.  This
might  mean  having  a  plan  for  laboratory  sessions  taking  longer  or  having
extra staff being able to help in the  laboratory (this  will obviously depend on
your environment and setup). Remember that this  is  a  temporary  solution,
so  a  lower specification machine  may be  acceptable  for the  short-term,  and
most modern entry-level computers  will function sufficiently  as  a  LabTutor
Server for a  definitive  period until your  primary  LabTutor  Server  has  been
restored.

Do not install this spare computer with LabTutor Server. Doing so may cause
conflicts,  especially  if  both  servers  are  configured  to  connect  to  LabTutor
Online. Instead, have the installer  handy and make  sure  it  is  the  same  as  the
installed version on the primary LabTutor Server.

Ideally this spare computer will not be  in active  use, but if  this  isn’t possible,
ensure  that it  can be  easily acquired i.e.  you won't have  to  wait  for  another
user to finish work, or have to copy data off before you can use it.

This  spare  computer should, if  possible,  be  installed with  a  clean  Operating
System that is  the  same  version  as  your  primary  LabTutor  Server.  As  with
your primary server, it  should not be  installed with any software  that  could
conflict  with  LabTutor  Server  or  the  ports  that  are  required  for  LabTutor
access.

Pre-configure any network/domain access, and anything else that will make  it
quicker  to  get  this  computer  functioning  as  a  LabTutor  Server  with  short
notice.

The  computer  name  for  your  substitute  computer  must  be  unique  on  the
network, i.e. not the same as your primary LabTutor Server.

It  is  advisable  to  have  a  full  disk  image  of  your  primary  LabTutor  Server,
both  as  a  clean  computer  with  only  the  OS  installed,  and  with  LabTutor
Server in a working state. In the event of a disk failure to your primary server,
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this image will help you get the  primary machine  running sooner. There  are
many  third  party  software  packages  that  can  do  this,  such  as  Acronis  or
BootIT NG.

Ensure  that  you  have  a  written  plan  for  a  disaster  recovery  scenario  that  has  been
discussed  with  other  staff  and  stakeholders.  This  should  be  in  an  easily  accessible
location in both digital and printed form.

In the event of a disaster (e.g. a complete failure of the  LabTutor Server computer) the
best option is to have a standby computer that is  ready to  take  on the  workload of the
failed LabTutor Server computer.

Backup the Primary Server
Implement a backup strategy to ensure that a  frequent copy of  the  LabTutor
Server data  is  placed into  secure  locations.  This  strategy  should  include  the
data  being stored in an easily accessible  location on-site,  so  it  can quickly be
restored to your substitute server. You may wish to back this up to  the  actual
substitute  machine.  Ideally  more  than  one  previous  version  should  be
available, as you don't want to risk overwriting a  good backup with a  corrupt
one.

Ensure  an  off-site  backup  is  also  taken  at  frequent  intervals.  Again,  this
should be  fairly easily accessible  in the  event you  need  to  restore  from  this
backup.

Consult the backup guide for more information.

Take a Disk Image
It  is  advisable  to  have  a  full  disk  image  of  your  primary  LabTutor  Server,
both  as  a  clean  computer  with  only  the  OS  installed,  and  with  LabTutor
Server in a working state. In the event of a disk failure to your primary server,
this image will help you get the  primary machine  running sooner. There  are
many  third  party  software  packages  that  can  do  this,  such  as  Acronis  or
BootIt.
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Course
Administration33

Start of Semester
At the start of a course there are several things that you should do:

1. Install experiments
Install all of the experiments needed for the semester.

2. Create a course
Give the course a name that students will be able to recognize (e.g. BIOL101).

3. Add experiments
Add experiments to the course.

4. Update student lists
You can import lists of students from tabs separated (.txt),  comma separated
(.csv), or Microsoft Excel 97-2003 format (.xls) documents.

5. Ensure your administrator and instructor details are up-to-date.
Ensure  that  your  administrators  and  instructors  have  LabTutor  Server
usernames and passwords.

An administrator has  full access  to  all  LabTutor  Server  functions,  while  the
instructor's  role  is  restricted  to  tasks  related  to  teaching  a  course  (such  as
locking and reviewing experiments).

Assign Instructors to restricted courses

6. Check LabTutor Online is connected and  that  a  licensing  protocol
has been established

The LabTutor Online administration pages allow you to  check that LabTutor
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Online is syncing with LabTutor Server correctly.

You  should  decide  on  either  Bulk  or  Individual  Student  licensing,  set  this
appropriately in the  Accounts and Licensing tab  of  the  administration pages
and obtain licenses where necessary

Throughout the Semester
While a course is running there are several things to keep in mind.

1. Add experiments
Experiments  you add to  a  course  are  immediately available  to  students,  but
you don't have to add all of the experiments to the course  at the  very start of
the  semester.  If  you  don't  want  students  to  access  experiments  too  far  in
advance, you can add experiments to the course throughout the semester.

2. Lock experiments past their due date
This  means  that  students  will  no  longer  be  able  to  edit  their  experiments.
Any non submitted experiments that students  have  started will be  moved to
Completed  but  marked  as  Past  due  (was  not  submitted).  You  can  also
unlock an experiment for individual students or for all students.

3. Avoid updating experiments part-way through a course
Updating Experiment: Adding a  new experiment with the  same  name as  an
existing experiment.

Updating an experiment will not replace  the  old version (unless  checked; see
below). This  means that students  who have  started  the  experiment  will  see
the new version and the old version of the experiment when they log in.
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It is  best practice  not  to  update  experiments  mid-way  through  a  semester.
You  should  only  update  experiments  mid-way  through  a  course  if  major
issues are found that you want to fix for later students. It is advisable that you
name  the  updated  experiment  appropriately  so  that  students  know  which
one they should use (e.g. "Experiment 4 -  EEG (New)").  If  you check 'Replace
existing versions in Course lists' upon uploading, the  new version will not be
available to students who have already started editing the former version.

End of Semester
At the end of a course there are several things that you should do  to  tidy up LabTutor
Server and prepare for the next course.

1. Archiving student data
When you  archive  student  course  data,  the  report  pages  for  all  submitted
and  in  progress  student  experiments  are  archived  as  PDF  files.  All  other
student experimental data  for that course  will be  deleted. Archiving reduces
clutter and disk usage. If you use  LabTutor Online, a  mechanism is  provided
for  you  to  save  archived  data  to  a  local  machine.  Archiving  provides  a
convenient  method  for  starting  a  new  semester  with  a  clean  slate,  while
keeping a record of previous students.

2. Deleting student data
If you don't want to  retain an archive  of  the  report page, you can just delete
all of the student data.

3. Deactivate students
Deactivated students  cannot start,  preview, edit or submit any  experiments,
but they can still  view  experiments  they  have  started.  Deactivated  students
are  not  allocated  with  new  LabTutor  Online  licenses.  You  can  also  delete
students to completely revoke their access to LabTutor.

If  you do not deactivate  students  at the  end of the  semester and you  are  in
Bulk licensing mode, they will be automatically issued a new LabTutor Online
license when they next log in to LabTutor, once the current license expires.

4. Updating your courses
In  anticipation  of  a  new  semester,  old  experiments  should  be  removed  or
updated.
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Removing/Adding Courses -  When students  log on to  LabTutor they see  all
of  the  courses  added to  LabTutor  Server.  Remove  any  old  unused  courses
and only add courses you need to keep clutter to a minimum.

What about students retaking a course?
You  can  protect  changes  being  made  to  student  credentials  in  the  Student  Details
section of the LabTutor Server administration pages.

Students
LabTutor  Server  includes  tools  to  help  you  manage  your  student  list.  The  import
function allows entire student lists to be imported and set up with a login credentials.

How can I alter class lists?
Importing  a  class  list  with  the  required  changes  automatically  updates  the  current
student  list.  Changes  can  also  be  made  manually  to  individual  students  from  the
administration pages.

Active vs Inactive students
In Bulk licensing mode, active students will pick up LabTutor Online licenses when they
log in. Deactivating a student means that they do not pick up licenses, and can not start
new experiments or preview experiments using LabTutor Online. Inactive students  can
be easily reactivated in the administration pages

Deleting students
Students  must  be  deactivated  before  they  can  be  deleted.  This  makes  it  harder  to
accidentally remove a student and lose their data.
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Is there a limit on class sizes?
There is no limit on the number of students in a class list.

Passwords
If  you don't give  students  passwords  they  are  prompted  to  create  one  the  first  time
they log into LabTutor. If  they forget or lose  their  password, these  can be  reset in the
administration pages.

Group Login

Students  can form a  group to  work  on  an  experiment  by  logging  in  together  on  the
same computer.

What is the largest group size?
There can be up to 8 students logged in as a single group.

Are groups permanent?
No. Students can work in different groups each session if  they are  accessing a  different
experiment each time.

What if a student is absent?
Absent students  are  able  to  be  added into  a  group that is  currently in progress  by an
Administrator or Instructor. This  allows them access  to  all of  the  student data  in that
experiment. They can then complete the experiment with the group or on their own.

Do groups  who  start  an  experiment  together  have  to  submit  it  as  a
group?
 If a group of students  work together on an experiment in the  lab, they then have  the
option of re-forming the same group to continue working on their experiment later,  or
finishing the experiment individually or in smaller groups. A group can be  divided into
smaller groups, or individual students, by simply logging into  LabTutor separately (or
as a smaller group). The branching of their original work will be  done  automatically by
LabTutor Server.

If  a  group  changes,  what  happens  to  the  data  completed  in  other
groups?
If  students  log in as  different  groups,  previous  work  from  earlier  groups  will  not  be
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available  to  the  new group. When  the  students  log  back  into  the  original  group,  the
data will be available again. Logging in individually will allow the student access  to  all of
the experiments they have been working on.

Session Expiry

Students will be logged out after 30 minutes or more of  inactivity. This  will occur when
they next try to  navigate  on the  page, or sample  data  from the  PowerLab. All student
data will be retained.

The  same  user  is  only  allowed  to  be  logged  into  one  machine  at  a  time.  If  you  are
logged into a machine as  'USER1' and then log into  a  different machine  with the  same
user, the first session will expire. This happens within 30 seconds of  the  user logging in
somewhere  else,  but  usually  you  will  see  it  within  5  seconds.  If  the  first  session  is
inactive  (i.e.  page  idle) it  may  display  for  longer,  but  any  attempt  to  sample  data  or
answer questions will force LabTutor to check the session is permitted.

Completing Experiments

What can students do with completed experiments?
Depending on course  options set in the  administration  pages,  reports  are  able  to  be
printed, submitted or emailed.

Printed reports
The  report  page  can  be  printed  if  the  print  option  has  been  activated  by  the
administrator in  the  course  list.  This  does  not  submit  the  report,  but  brings  up  the
print dialog and prints a correctly-formatted report. Using the browser's  print function
will print the report page, however page breaks and formatting may be incorrect.

Submitted reports
Clicking the  Submit button will tag the  experiment as  completed and the  student will
no  longer be  able  to  make  changes, but  will  still  able  to  view  the  experiment.  When
students  submit  their  experiment,  administrators  can  configure  themselves  to  be
emailed a PDF of the report page. The administration pages can also be used to allow a
student to resubmit an experiment.

Emailed reports
There  are  two  separate  ways  that  reports  can  be  emailed.  If  the  Email  button  is
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available, students can email a PDF or .docx file of the  report page  to  themselves  or to
any other valid email address. This does not submit the report. If the  option to  email a
submission report has  been selected, then when the  student submits,  the  report page
will automatically be sent to the configured email address.

Differences  between  LabTutor  Online  and  PowerLabs  Required
modes

Printing - no difference

Submitting  -  If  the  server  is  in  LabTutor  Online  mode,  all  submitted
experiments  are  converted  to  LabTutor  Online.  If  students  wish  to  view
submitted experiments in the classroom, they will automatically be redirected
to LabTutor Online. 

Email - In PowerLabs Required mode, reports can be  sent as  either PDF or .
docx documents. In LabTutor Online mode, only PDF reports may be sent.

Reviewing

LabTutor provides  a  review  feature  to  allow  Instructors  and  Administrators  to  view
student  reports  and  experiments.  Experiments  can  be  reviewed  multiple  times
regardless  of  whether  they  have  been  submitted  or  remain  in  progress.  The  way  in
which experiments  are  accessed  for  reviewing  depends  on  which  LabTutor  licensing
mode is being used. 

Instructors  and  Administrators  are  able  to  view  students'  experiments  at  any  time
using the Student Data Review feature. Reviewing allows you to:

View a student's experiment in its entirety.

Access information about when the  experiment was started and when it was
last  accessed,  the  time  spent  doing  the  experiment  and  whether  the
experiment has been submitted, locked or is in progress.

Experiments are sorted by date  started, with those  accessed first at the  top of  the  list.
Reviewing a  student experiment does not  change  its  status  or  store  a  record  of  that
experiment as  having being reviewed. No  changes,  annotations  or  comments  can  be
made when reviewing experiments

Reviewing in PowerLabs Required mode
If LabTutor is in PowerLabs Required mode, experiments can be reviewed through the
LabTutor  Server  administration  pages.  To  review  student  experiments  you  need  to
have  LabTutor  Client  installed  on  the  computer  you  are  using  and  use  Microsoft
Internet Explorer 7 or later.
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Reviewing in LabTutor Online mode
If  LabTutor  Online  has  been  activated,  experiments  may  be  reviewed  anywhere  an
Internet connection is available. Any common web browser may be  used, but Flash is
required  to  view  the  data  panels  in  the  report.  You  do  not  need  to  have  LabTutor
Client installed to review experiments when using LabTutor Online.

Marking
The  marking and assessment of  experiments  is  not  an  inherent  feature  of  LabTutor
and no changes, annotations or comments  can be  made  when reviewing experiments.
Adobe Reader X now allow you to  add comments  to  PDFs, which would allow you to
annotate  the  student  report  pages  that  LabTutor  emails  to  you.  For  this,  the  latest
version of Adobe Reader is recommended.

Experiment Data

What is Student Data?
Student data  is  any recorded data, answers  to  questions, or information  entered  into
tables  that  is  generated  or  added  by  a  student.  The  data  for  each  experiment  is
associated with the student who generated it and is  stored within the  LabTutor Server
file system. 

If  the  student  was  logged  in  as  part  of  a  group  when  the  data  was  generated,  each
student in the group has the data associated with their login details. This ensures  that if
the  members  of  the  group  want  to  submit  individual  reports  or  split  into  smaller
groups, that their original data is not lost.

Student data is managed through the  LabTutor Server database. The  LabTutor Server
database  maintains  the  integrity  of  the  associations  between  each  student  and  their
experimental data. The database tags the student data as being in one of  four states:  In
Progress, Past Due, On LabTutor Online, or Submitted. Once students  have  started an
experiment, the  state  of  that experiment session becomes ‘In  Progress’.  Students  can
access  an experiment by previewing it,  but  it  will  not  be  In  Progress  and  no  student
data will be stored.

Transferring Student Data to LabTutor Online
When  student  data  is  transferred  to  LabTutor  Online  it  can  no  longer  be  accessed
again in LabTutor Client by the student.

Once  experiments  are  edited  in  LabTutor  Online  they  can  no  longer  be
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accessed  again  in  LabTutor  Client  without  an  administrator  rolling  the
experiments  back  to  its  pre-LabTutor  Online  state.  Doing  so  means  any
changes made  in LabTutor Online  will be  lost.  If  students  attempt  to  access
these  experiments  in  LabTutor  Client,  they  will  be  redirected  to  LabTutor
Online.

Submitted  experiments  are  always  transferred  to  LabTutor  Online  once
submitted. 

Reviewing an experiment that has  not been transferred to  LabTutor  Online
will  not  result  in  that  experiment  becoming  inaccessible  to  the  student  in
LabTutor Client - a temporary upload is made of  that experiment for review
purposes only. 

Experiment Cache
Versions of  LabTutor prior to  LabTutor 4 Suite  used an experiment files  cache  which
had to be cleared before each student session, when all students used the same login.

Because  LabTutor  4  Suite  saves  all  student  data  directly  to  the  LabTutor  Server
database,  there  is  no  experiment  files  cache  and  it  is  not  necessary  to  clear  files
between student  sessions.  Each  student  will  see  their  experiments  in  the  same  state
they left them the last time they logged out. The only exception to  this  is  if  a  student is
a  member  of  a  group  and  the  branches  of  the  group  experiment  data  have  been
collapsed by an administrator or instructor.

Archiving Student Data

After the end of a  course  or semester, student data  is  able  to  be  archived and stored.
This  allows  for  students  to  be  deactivated  or  deleted,  whilst  retaining  an  archive  of
their data.

How do I archive data?
Each course  page  has  a  button for archiving data. When it is  clicked, all of  the  report
pages from each student run are stored as PDFs.

How do I access the archived data?
Archived  data  can  be  accessed  via  the  administration  pages.  If  you  are  operating  in
PowerLabs Required mode, the  reports  can be  accessed via  the  administration  pages
or  the  Archived  Student  Data  folder  (C:\Program  Data\ADInstruments\LabTutor
Server\Archived Student Data). If you are in LabTutor Online mode, then the  archived
data can be accessed via  LabTutor Online. You can search through archived data  and,
when it is found, simply click on the experiment to open the saved report as a PDF. 
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Are there other ways of backing up archived data?
In  LabTutor  Online  licensing  mode  only,  archived  data  is  also  able  to  be  accessed
securely via SFTP (Secure File Transfer Protocol). To utilize  this  feature, an SFTP client
will  need  to  be  installed  on  the  computer  being  used  for  access.  Clients  such  as
Cyberduck  and  Filezilla  are  free  applications  available  online,  and  compatible  with
most Macintosh and Windows operating systems. In the  Archives  tab, Back-up Access
is  a  feature  which  configures  credentials  to  access  archived  student  data  via  SFTP.
These  credentials  are  only  valid  for  one  week,  but  may  be  re-validated  as  often  as
necessary.

Once the SFTP client has successfully connected with the host,  the  archived files  will be
displayed, organized into folders and able to be arranged according to  name, date, size
etc. From here, individual files  or folders  are  able  to  be  isolated and downloaded to  a
desired location on your local server.
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Exporting Student Answers

The  'Export Answers' feature  will export the  following  information  from  a  LabTutor
Experiment as a .csv file:

For Answer panels, the text entered by the student will be exported.

For  MCQ  panels,  each  possible  answer  has  a  numerical  value  assigned  in
LabAuthor, starting from "0".  The  numerical value  of  the  option(s) selected by
the student will be displayed.

For Sub page order and/or select panels, the  sub  pages  are  labeled "0, 1,  2,  3..."
and so forth, corresponding to their  positions within the  established 'Available'
list. The number(s) selected by the  student are  exported in the  order that they
are arranged by the  student, with the  sub  page  at the  top of  the  list appearing
first.

Meta-information pertaining to  the  exported experiment will be  prefixed with
a  '#'  symbol,  and  displayed  at  the  top  of  the  exported  file.  This  meta-
information comprises:

Course name

Experiment name

Number of student answer rows exported

Average time taken

Number of In-Progress, Submitted and Past Due experiments

Numbers of answers exported for a row

Answers  will  be  arranged  within  the  .csv  file  alphanumerically  based  on  the
'LabTutorPageItem' ID assigned to  the  Answer, MCQ or sub  page  panel.  These  page
item IDs should therefore be established in LabAuthor with this feature in mind.

Furthermore, educators may have Experiment marking schemes which may be  used in
conjunction  with  the  Export  Answers  feature.  Formulas  may  be  set-up  on  a
spreadsheet, which output a 'mark' based on the  contents  of  a  cell.  These  outputs  may
then be used to create a graph.
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Maintenance &
Technical Info44

LabTutor Server
Software Updates

When should I update LabTutor Server?
It  is  recommended  that,  if  possible,  you  should  always  use  the  latest  version  of
LabTutor Server. It is advisable to update LabTutor Server between semesters  as  there
may be discrepancies between the data formats used (for server snapshots  etc.).  If  you
do update during the semester, you should update outside of course hours, so that you
can  be  sure  that  no  students  are  connected  via  LabTutor  Client.  If  you  update
LabTutor Server while students are performing an experiment, data loss could occur.

How can I update all of my client computers?
If  the  server detects  that  the  client  computer  is  running  an  old  version  of  LabTutor
Client, you will be prompted to update to a newer version when you try to  log in. The
update will be provided directly from LabTutor Server, rather than over the Internet.

Updating LabTutor Online
LabTutor Online  is  maintained by ADInstruments  independently of  LabTutor  Server
and  LabTutor  Client.  Because  of  this,  users  will  always  have  the  most  up-to-date
version of LabTutor Online (that is compatible with their version of LabTutor Server).

Uploaded Experiments

You  can  access  experiment  installers  that  have  been  uploaded  to  LabTutor  Server
through the administration pages.
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LabTutor Server stores  its  data  in a  folder in the  ADInstruments  area  of  the  (hidden)
Program  Data  or  Application  Data  folder.  Under  no  circumstances  should  you
interfere  with  the  these  files  directly,  as  this  may  cause  LabTutor  Server  to  stop
working.

Server Recovery

Data is saved back to  the  server at regular intervals  upon user interactions and major
commits. Sampled data is regularly sent back to LabTutor Server so that in the event of
a system failure most data will be retained

What  happens  in  LabTutor  Client  when  sampling  data  during  an
experiment and a snapshot is performed of LabTutor, on the Server?
When  a  server  snapshot  is  performed  while  students  are  in  a  laboratory  using
LabTutor,  students  should  not  notice  anything.  Sampling  will  continue  and  student
sessions do not expire. No loss of data will be experienced.

What  happens  in  LabTutor  Client  when  sampling  data  during  an
experiment and the server is restarted?
Student sessions will expire  and students  will be  logged  out  of  LabTutor  Client.  Any
data being sampled while the Server service is restarted, will be lost.

What happens if uploads to LabTutor Online are  in  progress  and  the
LabTutor Server service is restarted?
Experiments  will continue  to  upload successfully to  LabTutor  Online  after  the  server
service has restarted.

What happens when the PowerLab is disconnected during sampling?
If  the  PowerLab  power  cord  is  pulled  out,  the  PowerLab  is  switched  off,  or  if  the
PowerLab  USB cord is  disconnected  while  sampling,  the  recording  will  stop  but  any
data already recorded will be saved.

What happens if the client computer loses power while sampling?
Sampled data will be  lost when computer power is  lost while  sampling data. Also, the
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PowerLab may crash and will need to be reset (switched on and off).

Restarting LabTutor Server

If you need to restart LabTutor Server you can do this in one of three ways:

1. Restart the server computer.

2. Restart the ADInstruments LabTutor service  via  the  Services  control panel (
Control Panel > Administrative Tools > Services).

3. By  using  the  LabTutor  Service  Controller  that  is  installed  in  the
ADInstruments Start menu group (Start > All Programs > ADInstruments >
LabTutor Server > Service Controller).

Remote Access

LabTutor Server requires  outgoing access  to  the  Internet  to  contact  and  synchronize
with LabTutor Online, and to download experiments and updates. However, under no
circumstances  should  it  allow  incoming  connections  over  the  Internet.  Allowing
computers to connect to LabTutor Server over the  Internet is  a  security risk and not a
recommended  or  supported  configuration.  LabTutor  Server  has  been  designed  and
optimized  to  run  over  a  Local  Area  Network  (LAN),  and  not  over  the  Internet.  If
students  log  directly  into  LabTutor  Server  from  the  Internet,  this  will  result  in
extremely  compromised  performance  and  functionality.  These  students  would  also
need to have LabTutor Client installed on their computer, which is not compatible with
Macintosh or Linux operating systems. If students  require  remote  access  to  their  data,
LabTutor Online  is  the  only supported solution. LabTutor Online  removes  all  of  the
complications of performance, security and operating system dependence for accessing
student data over the Internet.

Security Certificate

The  default  security  certificate  that  is  generated  for  LabTutor  is  a  self-signed  SSL
certificate.  This  means  that  you  have  to  install  the  root  certificate  for  the  LabTutor
Server on all computers that access the administration pages, if you wish to remove  the
security warnings from browsers. It is  possible  to  supply your own SSL  certificate  for
use with LabTutor Server that is generated by a trusted Certificate Authority (CA) such
as VeriSign or Go Daddy, or one generated by your own Certificate  Authority, such as
Active Directory Certificate Services (AD CS).

LabTutor Server requires  the  SSL  certificate  to  be  in  Tomcat  format  (pkcs12).  Many
CAs will allow you to download the  certificate  in Tomcat format directly. Alternatively

http://www.verisign.com/
http://www.godaddy.com/
http://www.godaddy.com/
http://technet.microsoft.com/en-us/windowsserver/dd448615
http://technet.microsoft.com/en-us/windowsserver/dd448615
http://technet.microsoft.com/en-us/windowsserver/dd448615
http://technet.microsoft.com/en-us/windowsserver/dd448615
http://technet.microsoft.com/en-us/windowsserver/dd448615
http://technet.microsoft.com/en-us/windowsserver/dd448615
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OpenSSL can be  used to  convert most certificate  formats  into  the  pkcs12 format. The
certificate must be generated with the standard Tomcat password of "changeit".

Once  you  have  the  certificate  in  pkcs12  format  you  can  install  it  by  backing  up  the
existing "server.p12" file,  replacing it with the  new certificate, and  restarting  LabTutor
Server.  You  can  inspect  the  certificate  in  your  browser  to  verify  it  matches  the
certificate you expected. The "server.p12" can be found in the following locations:

Windows  Vista,  Windows  7  and  Server  2008:  C:
\ProgramData\ADInstruments\LabTutor Server\ssl 

Windows Server 2003: C:\Documents and Settings\All Users
\Application Data\ADInstruments\LabTutor Server\ssl 

LabTutor Client
LabTutor  Client  is  installed  on  each  computer  in  the  student  laboratory.  LabTutor
Client  works  in  the  background  and  silently  handles  communication  with  LabTutor
Server and the  PowerLab. Once  LabTutor Client is  installed, you access  can LabTutor
through your Internet Explorer web browser. 

The  easiest way for students  to  access  LabTutor  is  to  provide  a  desktop  shortcut  or
browser  bookmark  to  the  student  login  page.  The  student  login  page  can  also  be
manually entered into your web browser:

http://<LabTutor Server computer name> e.g. http://labtutor-server/

http://<LabTutor Server IP Address> e.g. http://192.168.1.58/

Updates
LabTutor Client must always be  the  same  version as  the  LabTutor Server.  There  are
three recommended ways for updating LabTutor Client computers:

Method 1: Via the LabTutor Login Page

If  the  server detects  that  the  client  computer  is  running  an  old  version  of  LabTutor
Client, you will be prompted to update to a newer version when you try to  log in. The
update  will  be  provided  directly  from  the  LabTutor  Server,  rather  than  over  the
Internet.

Method 2: Using the LabTutor Suite DVD

You can install LabTutor Client from the supplied LabTutor Suite DVD.

Method 2: Administrative Deployment (recommended for many computers)
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The  LabTutor  Client  MSI  installer  supports  administrator  deployment  from  the
command line for silent, first-time or updated installs.

LabTutor Online
Once  a  student has  edited  their  experiment  in  LabTutor  Online,  the  student  will  no
longer be able to record data in the laboratory using LabTutor Client. 

 Students  must complete  data  acquisition and analysis  (tables,  graphs etc.) before
editing their experiment via LabTutor Online.

LabTutor Server and LabTutor Online Interaction
Communication between LabTutor Server and LabTutor Online  is  one-way, meaning
that once  you've  clicked the  Edit  button  in  LabTutor  Online,  the  experiment  can  no
longer  be  edited  back  in  the  classroom  using  LabTutor  Client.  This  means  that
additional data cannot be sampled from a  PowerLab  or added as  example  data, tables
can no  longer  be  completed  and  graphs  unable  to  be  populated.  Once  in  LabTutor
Online,  students  can  still  analyze  data,  tables  and  graphs  and  can  type  text  into  the
answer panels.

Conversion of Student Data

LabTutor  Online  requires  a  different  data  format  to  that  used  by  LabTutor  Server.
When  a  student  first  edits  their  experiment  online,  their  data  is  converted  to  the
LabTutor Online  format. Experiments  with high  amounts  of  data  will  take  longer  to
convert than experiments with low amounts  of  data. Students  can still preview labs or
view their  current progress  in LabTutor Online  without changing its  format, but once
the  students  click the  Edit button  the  experiment  data  is  converted  to  the  LabTutor
Online format. 

Queuing

LabTutor can only convert one experiment to the LabTutor Online format at a  time. If
multiple  students  access  LabTutor  Online  and  simultaneously  need  an  experiment
converted, they will be queued. Queuing for conversion is on a first-come basis.

Why are some experiments grayed out on LabTutor Online?
LabTutor Server may still be in the  process  of  uploading the  experiments  to  LabTutor
Online. The amount of time this takes depends on:

The network connection
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The size of the experiment

The number of experiments being uploaded

If experiment conversion is taking place

If the experiments remain disabled after a significant amount of time, you may need to
 restart the LabTutor Server.

Changing Server Hardware

Authentication of LabTutor Server with LabTutor Online  is  based on both the  Media
Access  Control  (MAC)  address  and  hostname  of  the  LabTutor  Server  computer.
Changing network cards or the computer name  of the  server computer will break this
connection.

If the computer name or network card is changed, an administrator will need
to  go  to  the  administration  pages  of  LabTutor  Server  and  re-authorize  the
machine for LabTutor Online.

No LabTutor Online  information will be  lost  because  the  database  has  not
changed.

Activating LabTutor Online

Activation of LabTutor Online requires  a  LabTutor Online  Activation Certificate  from
ADInstruments. This will be emailed to  the  original purchaser of  LabTutor Online  for
your LabTutor Server. The  certificate  should  be  saved  to  a  safe  location  that  can  be
accessed by LabTutor Server.

You should decide on either Bulk or Individual Student licensing, set this  appropriately 
in  the  Accounts  and  Licensing  tab  of  the  administration  pages  and  obtain  licenses 
where  necessary.  Individual  Student  licenses  (scratch  cards)  may  be  obtained  from 
authorized resellers or education providers whereas Bulk licenses can be purchased from 
myLabTutor.com, or by clicking on the myLabTutor.com link on the header of the 
admin pages. You can also send an email to: support.lto@adinstruments. com for 
assistance, or contact your sales representative directly.

Diagnosing Connectivity Issues

LabTutor Server requires  a  direct connection to  the  Internet on ports  80  and  443  for
syncing  with  LabTutor  Online  and  downloading  software  updates  and  experiment
installers.  The  most  common  connectivity  issue  is  caused  by  a  proxy  server  on  the
network or a  firewall that blocks direct access  to  the  Internet.  If  your  network  uses  a
proxy  server  for  Internet  access  you  will  have  to  get  an  exception  put  in  place  that

http://myLabTutor.com
mailto:support.lto@adinstruments.com
mailto:support.lto@adinstruments.com
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allows LabTutor Server to directly access  LabTutor Online  and ADInstruments.com If
your  network  uses  a  proxy  server  please  talk  with  your  IT  department  before
deploying LabTutor Server. 

If you are experiencing connectivity issues  with LabTutor Server and LabTutor Online
that  do  not  appear  proxy  server-related,  please  contact  your  ADInstruments
representative. 

Licensing
There are two modes of operation for LabTutor Client, depending on the licensing
model that is purchased:

1. PowerLabs Required - A student can log in and start an experiment if the
computer on which LabTutor Client is installed has a PowerLab connected.
LabTutor Client must also be able to connect to LabTutor Server. Students
are able to edit experiments on computers that have LabTutor Client
installed and that can connect to LabTutor Server.

2. LabTutor Online is activated - Where LabTutor Online is activated, a
student can log in and start or edit an experiment on any computer on which
LabTutor Client is installed, as long as LabTutor Client can connect to
LabTutor Server. LabTutor Client can be installed on any number of
computers. No PowerLab need be connected to the computer running
LabTutor Client. In this case, licensing may be on a per-student (Student
Access Card - Compulsory or Optional) or pool (Bulk Licensing) basis.

Administrators may empower students to create their own accounts on LabTutor. This

http://adinstruments.com
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may  be  relevant  where  no  consolidated  student  registry  information  is  available  to
import  to  LabTutor  to  create  accounts  en  mass,  thus  saving  time  and  money  over
manually entering a student database.

Furthermore,  in  the  instance  of  LabTutor  Online,  where  the  onus  may  be  on  the
student  to  purchase  their  individual  license,  a  scratch  card  may  be  obtained  by  a
student  from  an  authorized  reseller  or  from  their  Education  Provider  and  entered
upon account creation. Bulk licensing also  exists  in LabTutor Online  mode, whereby a
license  is  effectively grabbed from a  pool of  available  licenses  by  an  active  unlicensed
student upon logging in.

If enabled by an administrator, individual LabTutor Online  and PowerLabs Required
accounts can be created by a student from the appropriate LabTutor login page.

Adding new Bulk Licenses

1. In LabTutor Online  mode, log in to  the  LabTutor Server  Admin  pages  as  an
administrator  and  navigate  to  Server  >  Accounts  and  Licensing  (ensure
Licensing mode is set to Bulk Licenses)

2. Click Add

3. When prompted, type you license and click Save

4. Your  licensing  status  will  be  updated  on  the  previous  page,  reflecting  your
changes.

NB: To purchase more bulk licenses, click the blue hyperlink Buy Licenses on myLabTutor.com to  be
redirected  there.  From  myLabTutor.com,  click  Get  More  Student  Licenses,  type  the  number  of
licenses required into  the  subsequent  License  Request  page  and click  Proceed  to  have  your  request
forwarded to your sales representative.

Bulk licenses  remain valid for 6 months from  their  time  of  activation.  A  bulk  license
becomes activated when a student first logs in to  LabTutor Server or Online, provided
sufficient licenses are available.

Bulk  licenses  must  be  activated  within  12  months  of  purchase.  Exceeding  12
months will deem the  license  invalid, and these  licenses  will be  removed from
LabTutor Server.

If a student is allocated a license and has his/her account deleted within a  week
of doing so, the  license  will become available  for  another  student  to  use.  If  a
student  account  is  deleted  more  than  a  week  after  being  allocated  a  license,
their license will become obsolete.

Unless  a  snapshot is  taken prior to  deactivating  LabTutor  Online,  active  bulk
licenses will be lost. Any available licenses prior to deactivation will be retained.
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Once  all  purchased  bulk  licenses  have  been  activated,  subsequent  first-time
student  logins  may  continue  to  be  allocated  licenses,  with  up  to  10%  of  the
original  number  of  licenses  being  purchased  able  to  be  attained  in  advance.
Any additional licenses used will be deducted from future purchases.

Students  with invalid bulk licenses  will prompt an error upon  logging  in  to  LabTutor
Client or Online, and be unable to preview or edit any experiments. This will also affect
group sessions regardless of whether all other members of the group are  licensed. The
unlicensed  user  or  users  will  have  their  login  symbol  grayed  out  in  the  Logged  in
dialog, whereas licensed users will appear blue.
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LabAuthor55
Experiments to be edited in LabAuthor are separate  from the  experiments  installed to
the LabTutor Server.

 You  cannot  and  should  not  attempt  to  edit  experiments  installed  to  LabTutor
Server directly. 

Best Practice
Have LabAuthor and LabTutor Server on separate computers.

Install Experiments  in a  local folder in your  User  directory  and  execute  the
experiment.adiexp file to open the experiment in LabAuthor.

Install your own custom experiments  in a  separate  location  to  the  supplied
ADInstruments experiments to avoid confusion.

Install experiments to a local folder. 
Double-click  on  a  LabTutor  Experiment  .ltexp  file.  This  will  open  the
LabTutor Experiment Installer.

Install ADInstruments experiments from the LabTutor Suite DVD.

Install ADInstruments  experiments  using the  Check for Updates  tool or the
Install LabTutor Experiments tool

 Start  >  All  Programs  >  ADInstruments  >  LabTutor  >  Check  for
Updates 

 Start  >  All  Programs  >  ADInstruments  >  LabTutor  >  Install
Experiments 

Experiment Flow
ADInstruments-authored  LabTutor  experiments  conform  to  a  high  standard.  Each
experiment  is  structured  in  a  similar  way  and  includes  background  information,
detailed  experimental  setup  and  exercises  as  well  as  easy-to-follow  data  acquisition,
analysis and reporting protocols.
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Experiment Flow
ADInstruments  experiments  follow  a  linear  flow  so  that  students  don't  need  to
navigate backwards and forwards throughout the lab.

General flow used by ADInstruments:

1. Introduction and background information

2. Equipment Setup

3. Experimental Exercise

4. Analysis of Results

5. Report

Example Data
Using LabAuthor you can record and embed example data into  a  LabTutor data  panel
which  demonstrates  what  the  student  should  typically  see  when  the  experiment  is
carried out. Recording example  data  is  identical to  recording data  normally  using  the
LabTutor panel. It simply needs to be "marked" as example data.

Adding example data using LabAuthor

The  students  performing the  experiment  will  be  able  to  access  the  example  data  by
right-clicking on the Start/Stop button and choosing Add Example Data…
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Example data shown in a LabTutor student experiment 

Audio and Video vs Other Media

Audio and Video Playback
LabTutor  has  built-in  codec  support  for  .h264  mp4  video  files  and  mp3  audio  files
using Flow Player.

Advantages of using .h264 mp4 video files with Flow Player:

Built-in cross-platform video player

Full-screen video playback

Subtitle support  as multiple subtitle tracks in the video file

Provide  a  low  resolution  video  for  LabTutor  Online  (for  fast  internet
viewing),  and  a  high  resolution  version  for  in  the  laboratory  (where  local
network bandwidth is less of an issue).

Poster  Images   Shown  as  a  placeholder  image  before  the  video  starts
playing.

Play  correctly  on  all  major  browsers  and  platforms  (Including  iPad  and
iPhone).

Advantages of using mp3 audio files with Flow Player

Built-in cross-platform audio player

Play  correctly  on  all  major  browsers  and  platforms  (Including  iPad  and
iPhone).

Note:  when  previewing  an  experiment  in  LabAuthor  with  .h264  encoded  videos,
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users will not be able to watch the video content. When accessed through a LabTutor
Server these videos will play as expected.

Other Media
LabAuthor can also embed other types of  media  files  such as  wav, wma, aac, avi,  mov
or wmv. For a full list, see the LabAuthor help.

These file formats rely on external software and will be displayed/played only
if the required software  is  installed and set up correctly (e.g.,  Adobe  Reader,
Flash, QuickTime, Windows Media Player etc.). As such, performance  can be
temperamental.  The  recommended  practice  is  to  use  content  that  is  fully
supported (.h264 encoded video, and mp3 audio files). 

Instructor's Material
Documents  can be  added to  the  LabTutor experiment that can be  accessed  from  the
LabTutor Server interface.

Location
If there is a folder named Instructors Material  in the  experiment directory when the  .
ltexp  installer  is  created,  then  any  files  in  that  folder  will  appear  in  the  Instructors
Material section of the LabTutor Server administration pages. The  instructors  material
folder should not contain any sub folders.
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The correct location of the Instructors Material folder for a LabTutor experiment.

Optimizing Experiments
It  is  important  to  keep  the  file  size  of  experiments  to  a  minimum  to  ensure  that
experiments  perform optimally, particularly when using LabTutor  Online.  Larger  file
sizes will still work; however students  may find themselves  in a  queue  while  waiting to
download an experiment. Depending on  the  volume  of  students  and  recorded  data,
queuing  time  may  vary  from  a  few  seconds  to  several  hours.  This  is  not  an  ideal
situation and should be avoided by following these best practices. 

1. Sampling rate
To reduce file size, choose the lowest suitable sampling rate  for the  recorded data. For
example, a  default sampling rate  of  1000 samples  per second  (i.e.  1k/s) is  suitable  for
most human biological recordings (e.g. spirometry, ECG, EOG, finger pulse  and blood
pressure). Other signals  may require  a  higher  sampling  rate  (e.g.  EMG  at  4k/s),  or  a
lower rate  will do  (e.g. pharmacology organ bath experiments  at  200–400  samples/s).
There  are  certain special cases  for which high sampling rates  are  required  for  quality
data, such as when recording action potentials.
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2. Fixed duration sampling
In LabTutor you can fix the duration of sampling, to say 30 seconds, for a  recording of
spontaneous nerve activity. For exercises where students have to  apply an intervention
or enter a  comment,  it  is  important  to  consider  whether  a  brief  sweep  would  allow
adequate time for this.

3. Instruct Students to Delete unusable data
If  you wish, you may choose  to  add an instruction  to  each  analysis  page  to  have  the
students  delete  unusable  data  before  completing the  exercise. Note: it  is  necessary  to
do  this  while  they  are  in  the  laboratory.  For  example,  the  following  instruction  has
been  added  to  version  2.1  of  the  Cockroach  Sensory  Nerve  experiment  on  each
analysis page:

 It  is  good  practice  to  delete  any  unusable  data,  and  it  will  improve  the
presentation of your Report for this laboratory. Before proceeding to the next exercise,
select the unusable data and click on the Delete Data button.

4. Reduce number of channels
The number of active channels in the referenced data file can have a large impact in the
data  file  size.  You  should  remove  any  unused  channel  calculations  and  reduce  the
number  of  channels.  The  channel  calculations  can  continue  to  be  run  even  if  the
channels are hidden, so ensure that unused channels are turned off.

5. Combine Channels
If you are proficient using LabChart, you may feel confident enough to  try to  combine
two  or  more  Channels  using  an  arithmetic  equation.  You  can  have  an  arithmetic
equation running on the  channel you are  recording into. For example, to  differentiate
Channel  1,  select  Arithmetic  from  the  channel  drop-down  menu  and  enter:  “=
Differentiate( Ch1 )”. This will return the derivative of channel 1 into Channel 1. Refer
to  the  Arithmetic  section  of   the  LabChart  7  Help  for  further  information  and
formulae.

Experiment Properties
When you use  LabAuthor to  create  or edit an experiment  it  is  important  to  provide
good experiment properties. In particular:

Experiment  Title:  This  is  the  full  name  of  the  experiment  as  seen  by  the
student. In some  circumstances  you may wish to  give  an indication as  to  the
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order  of  the  experiments  e.g.  "PHYS201  -  Lab  1  -  Blood  Pressure".  It  is
recommended  that  experiment  titles  be  less  than  40  characters,  including
spaces, in length. This  is  because  excessive  titles  can  cause  problems  to  the
header of an experiment page, pushing down navigation buttons.

Version: The  version  number  helps  you  keep  track  of  experiments  so  you
always know which one  is  the  most current version. LabTutor Server checks
the version number on installation of  experiments  so  that if  there  is  already
an experiment with the  same  properties,  it  is  able  to  tell  you  whether  it  is
older, newer or the same as the currently installed experiment.

Why you should use experiment version numbers
When amendments to experiments are made, you should increase the version number
by opening the Experiment Properties dialog from the  Edit menu in LabAuthor. You
can increase  the  version  number  in  point  increments  (e.g.  2.0  to  2.1)  or  point-point
increments (e.g. 2.0 to 2.0.1). This reduces confusion when uploading an experiment to
LabTutor Server when a  previous version already exists.  LabTutor Client will prompt
you  when  uploading  a  new  version  of  an  experiment  as  to  whether  you  intend  to
replace existing versions of that experiment on Course lists.

Note:  LabTutor  Server  will  not  allow  you  to  overwrite  an  experiment  that  has
identical Experiment Properties.

Learning Modules
Learning  Modules  allow  related  experiments  to  be  grouped  together,  with  different
components  intended  to  be  accessed  in  the  classroom  or  laboratory  (Client)  and
outside  of  the  classroom (LabTutor Online). Each component in a  learning module  is
only  accessible  once  the  previous  component  has  been  submitted.  This  creates  a
seamless  learning  experience,  whilst  giving  educators  increased  control  over  the
student's work-flow to benefit them maximally through active  reinforcement and self-
evaluation.

How to create a 'Learning Module' experiment: 

1. Open an existing experiment, or create a new one, in LabAuthor

2. Navigate to Edit > Experiment Properties
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3. Check the  box labeled Learning module: and define  a  title  for  the  learning
module. All  experiments  that  you  want  to  include  in  this  learning  module
must be  given the  same  learning  module  title.  N.B:  If  you  have  previously
authored a learning module, it will be  available  from the  drop-down for this
field.

4. Define  an Order: for this  learning module  component. In this  example,  the
tutorial  is  the  first  learning  module  component,  so  the  number  '10'  is
assigned  as  its  order.  Assigning  orders  in  increments  of  '10'  means  that
supplementary  or  alternative  components  can  easily  be  integrated  into  an
existing learning module, without having to  reassign the  entire  order.  i.e.  if
an educator decides to implement a second tutorial component, they may do
so,  and  assign  any  number  from  '11-19'  as  its  order  (assuming  the  next
component's order is '20').
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5. Click OK

6. Repeat steps 2-5 for each component of a given learning module, giving each
a relevant title and order number. i.e. For a Blood Pressure Learning Module
comprising a tutorial, pre-lab quiz, laboratory session, patient case  study and
evaluation,  the  following  attributes  would  be  applied  in  the  Experiment
Properties dialog for each.

Learning module title: 'Blood Pressure'

Experiment title: 'Tutorial'; Order: '10'

Experiment title: 'Pre-lab Quiz'; Order: '20'

Experiment title: 'Laboratory Session'; Order: '30'

Experiment title: 'Patient Case Study'; Order: '40'

Experiment title: 'Evaluation'; Order: '50'

Other Considerations:

Ensure  the  Experiment  author  is  identical  for  every  component  of  the
learning module. Experiment properties must be consistent throughout all
components of a Learning Module for them to be recognized and grouped
correctly  by  LabTutor.  If  you  edit  a  component  of  an  ADInstruments'
Learning  Module,  an  option  'Keep  this  experiment  part  of  the
ADInstruments' Learning Module' is selected by default. Keep this selected
to  maintain  the  edited  component  as  belonging  to  the  original  Learning
Module.  If  you  are  editing  every  component  of  an  ADInstruments'
Learning Module, it is recommended that you uncheck this and ensure  the
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 Experiment author: is kept consistent across the module.

The experiment installer will save  with the  following attributes: '<Learning
module name> - <Experiment title>.ltexp'

Learning modules can be distinguished from traditional experiments in the
Course pages by light-blue text:

The Experiment title: should be  kept brief  and only describe  that discrete
learning  module  component.  Ie.  "Tutorial",  as  opposed  to  "Autonomic
Nervous System -  Tutorial".  The  learning module  title  is  displayed  as  the
'parent'  of  the  learning  module  drop-down,  and  appears  in  the  student
pages as below:
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Troubleshooting

If a group login includes a mix of students who have  submitted  or  started  different
learning module components independently, the following error will be shown:

Scenario 1: A group comprises students  A,  B  and  C.  Students  A  and  B  started  and
submitted the Tutorial component of the learning module, whereas student C started
the Tutorial but did not submit it. As a group they are  now required to complete  the
Pre-Lab Quiz.

Solution 1: Student C should log in to  LabTutor  independently  and  simply
submit the Tutorial. Upon subsequently logging in as  a  group, with students
A and B, the Pre-Lab Quiz will be available.

Solution  2:  Log  in  to  LabTutor  Server  as  an  administrator.  Navigate  to
Student Data > Find and Manage  and search for the  submitted student data
pertaining to  the  Tutorial  for  either  student  A  or  B.  Click  Edit.  Under  the
heading Students, click Add. Type student C's  user ID or user name  into  the
box and click Search. When you have  located student C, click Add.  They will
now have submitted student data  for the  Tutorial,  and subsequently logging
in as a group, the Pre-Lab Quiz will be available.

Solution  3:  Log  in  to  LabTutor  Server  as  an  administrator.  Navigate  to
Student Data > Find and Manage and search for the in-progress student data
pertaining  to  the  Tutorial  for  student  C.  Click  Edit.  Under  the  heading
Status,  click  Lock.  This  will  classify  the  Tutorial  'Past  Due'  for  student  C,
therefore  making the  Pre-Lab  Quiz component available. The  Pre-Lab  Quiz
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will now be available to students A, B and C when they log in as a group.

Scenario 2: A group comprises students  A,  B  and  C.  Students  A  and  B  started  and
submitted  the  Tutorial  component  of  the  learning  module  at  home  the  previous
evening, whereas student C did not even start the  Tutorial. As a group they are  now
required to complete the Pre-Lab Quiz.

Solution 1: Student C should log in to LabTutor independently and start and
then submit the Tutorial.  Upon subsequently logging in as  a  group, the  Pre-
Lab Quiz will be available.

Solution  2:  Log  in  to  LabTutor  Server  as  an  administrator.  Navigate  to
Student Data > Find and Manage  and search for student data  pertaining  to
the  Tutorial  for  either  student  A  or  B.  Click  Edit.  Under  the  heading
Students, click Add. Type student C's user ID or user name  into  the  box and
click Search. When you have located student C, click Add. They will now have
submitted student data  for Tutorial and subsequently logging in as  a  group,
the Pre-Lab Quiz will now be available.

Scenario 3: A group comprises students  A,  B  and  C.  Students  A  and  B  started  and
submitted the Tutorial  component of the  learning module. Student C submitted the
Tutorial and the Pre-Lab Quiz, as well as starting the Laboratory. As a group they are
now required to complete the Pre-Lab Quiz.

Solution  1:  Log  in  to  LabTutor  Server  as  an  administrator.  Navigate  to
Student Data > Find and Manage  and search for student data  pertaining  to
the  Pre-Lab  Quiz and Laboratory for student C. Click Edit.  On  the  bottom
left-hand  corner  of  the  subsequent  page,  click  Delete.  This  will  remove
student  C's  data  for  the  submitted  Pre-Lab  Quiz  and  Laboratory  learning
module  components. They will  now  only  have  submitted  the  Tutorial,  and
the Pre-Lab Quiz will be available to students A, B and C when they log in as
a group.

 Learning  Module  experiments  must  contain  a  Report  page  (and  Submit  turned  on  in  Admin
pages) so that the next Learning Module component can be accessed.
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Troubleshooting66
This section contains some  frequently asked questions and describes  actions to  take  if 
you encounter problems using the LabTutor Suite. Further information can be found in 
the LabTutor Server help and via adinstruments.com

Technical Support
There is always the potential for problems to arise that will stop LabTutor Server from
functioning  correctly,  if  you  find  yourself  in  such  a  situation  please  contact  your
ADInstruments representative for further assistance. They will be  able  to  assist you in
gathering diagnostic information from your server to help resolve the issue.

Forum
The  ADInstruments  Software  Forum  provides  an  interactive  online  environment 
where  PowerLab  users  and  ADInstruments  product  and  application  specialists  can 
share their knowledge and expertise. It provides a great place to ask questions, make 
suggestions, share ideas, tips and experiments. You can access the forum at  
adinstruments.com/forum/

FAQ
If the experiment is saved on different computers but not on the server, how can I
access this and continue working?

In  LabTutor  4,  experiments  must  be  installed  to  LabTutor  Server  to  function
properly. Local experiment installs  are  for  creation  and  editing  using  LabAuthor
and  are  not  intended  for  usage  in  a  classroom  situation  as  data  sampled  and
recorded outside of LabAuthor will not be saved.

How many copies of the same experiment can be submitted? What if a student is
working on the same experiment by logging on from different computers?

Each student can only submit  an  experiment  once.  The  number  of  computers  a
student uses to perform an experiment does not matter, as all data is stored on the
LabTutor Server. Students  cannot have  more  than one  active  session. If  a  student

http://www.adinstruments.com
http://www.adinstruments.com/forum/
http://www.adinstruments.com/forum/
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logs in using another browser or computer, the  other session will automatically be
logged  out  upon  navigating  to  a  new  page  or  performing  an  action,  such  as
sampling data.

What happens if a student starts an  experiment  with  one  group,  then  leaves  to
join another group without the first group logging out and logging back in?

Students  cannot  have  more  than  one  active  session.  If  a  student  logs  in  with
another group of users,  then the  first group will be  logged out  automatically  and
they will need to log back in without that student.

What will happen if a student logs in to LabTutor Client and/or Online using two
different browsers/browser windows at the same time?

Students  cannot  have  more  than  one  active  session.  If  a  student  logs  in  using
another browser or computer, the other session will automatically be logged out.

Is there a way to setup LabTutor to use another port besides 80, 443, or 8005?

No

How do I find out what programs are using ports 80 and 443?

The LabTutor Installation Advisor will detect this situation if it arises. You can also
manually  check  this  from  the  LabTutor  Server  computer.  Open  a  command
prompt window by looking in All  Programs > Accessories  and right click on  the
command  prompt  item,  then  select  'Run  as  Administrator'.  Once  the  window
opens type 'netstat -oan'. This  will show you a  list of  all the  listening services, the
port they  are  using  and  the  process  ID.  This  information  can  then  be  given  to
your Tech Support provider. The  most common scenario  is  that these  ports  are
already in use by Skype.

How do I stop Skype and VMware Server using ports 80 and 443?

If  you  have  Skype  installed  on  the  same  machine  as  LabTutor  Server,  this  can
result  in  ports  80  and  443  being  utilized  by  Skype,  and  therefore  not  being
available  for  LabTutor  Server.  You  can  get  around  this  without  reducing  the
standard functionality of Skype  or uninstalling it.  Go into  Skype  and click Tools >
Options > Advanced > Connection and uncheck the  box  that  says  'Use  port  80
and 443  as alternatives for incoming connections'.  VMware  Server also  has  the
same issues, and shouldn’t be installed on the same machine as LabTutor Server.

What is the minimum Hard Drive size for running LabTutor server?

This depends on a  number of  factors  including the  number of  students, number
of experiments, and the amount of data collected. It is recommended that you use
the Installation Advisor.
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I have .NET Framework version 4, do I still need v2.0 Service Pack 2?

Yes, you will still need .NET v2.0 Service  Pack 2 or v3.5 Service  Pack 1. The  .NET
Framework 4  works  side-by-side  with  older  Framework  versions,  but  does  not
replace them.

How many administrators can you have on one server?

The number is  not restricted, but it  is  recommended that you do not have  more
administrators than necessary in order to retain high system security.

What are the main differences in access for Administrators and Instructors?

An Instructor can:

Access Instructor’s material for experiments

Add  or  update  ADInstruments  experiments  from  the  install  media  or
ADInstruments website

Add or update custom experiments

Add individual students

Edit students (including deactivating and resetting passwords)

Delete individual student data

Edit student experiment data

Add students to experiment groups

Allow resubmission of experiment reports

Reset Checkpoints

View the status of experiments

Access archived Student Data

Configure  and  manage  access  to  any  restricted  course  they  may  be
assigned

An Administrator can do all that an Instructor can do and, in addition, can:

Configure the server with the department and organization names

Set the database backup time

Download and install a LabTutor Server Admin Certificate

Activate LabTutor Online

Configure LabTutor Online display options

Change LabTutor Online
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Add and delete Administrators

Add and delete Instructors

Reset passwords for Administrators and Instructors

Import student lists

Export student lists

Bulk deactivate students

Bulk delete students

Delete student data.

Backup access to archived data via SFTP

Export student answers

Archive Student Data

Assign students to restricted courses

Assign Instructors to restricted courses

Can the administration pages be accessed remotely?

Yes,  when  working  on  other  computers  on  your  local  network,  access  the
administration pages remotely by either:

Typing http://<LabTutorServer computer name>.<domain>/admin/

Typing http://<LabTutorServer IP Address>/admin/

Administrators cannot access the administration pages from a computer that is not
on the  same  network unless  the  IT  department  has  setup  specific  remote  access
software.

Can marking be done via LabTutor Online?

LabTutor  provides  a  review  feature  to  allow  Instructors  and  Administrators  to
view  student  reports  and  experiments.   The  way  in  which  you  access  the
experiments  for  reviewing  depends  on  which  LabTutor  licensing  mode  is  being
used. See Reviewing.

Is it necessary to install the browser security certificate?

No,  it  is  not  required.  The  certificate  verifies  that  the  LabTutor  Server
administration  pages  are  secure,  avoiding  browser  security  warnings.  If  not
installed,  you  will  have  to  approve  these  warnings  each  time  you  access  the
administration pages. See Security Certificate.

How do you upload instructor material for custom experiments?
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You must use LabAuthor to add the  Instructors  Material to  an experiment. These
files are then installed along with the  experiment, and accessed via  the  Instructors
Material tab in the administration pages.

What is the required format for importing/exporting student list?

You can import student details  in bulk from  a  file.  The  file  containing  the  list  of
student details  should be  formatted so  that the  details  for  each  student  are  on  a
separate row, with columns separated either by tabs (.txt) or commas (.csv),  or the
file  should  be  in  Microsoft  Excel  97-2003  format  (.xls).  Note  that  for  Excel
documents,  only  data  contained  on  the  first  sheet  of  the  document  can  be
imported.

For exporting a student list you can choose which columns of data  are  exported by
checking  the  boxes  beside  each  one.  The  Licensed,  Active  and  Protected  fields
export a value of 1 for yes  and 0 for no. The  export may be  limited to  a  subset of
the whole student list by selecting for only those students who are  Licensed, Active
or Protected. Data can be exported in comma separated value  (.csv),  tab  delimited
(.txt) or Microsoft Excel 97-2003 (.xls) formats.

Is  it  possible  to  get  a  list  of  students  who  have  or  have  not  submitted  an
experiment?

You can use  the  Student  Data  tab  within  the  administration  pages  to  see  which
experiments have not been submitted, and by whom. You can also  print this  page
out. The  Find  and  Manage  option  allows  you  to  see  the  status  of  all  unmarked
student data, whilst the Status tab allows you to search for an experiment based on
its status.

Is it possible to annotate and return student experiments?

No,  this  functionality  is  not  currently  available  from  LabTutor  Server.  You  can
print  or  export  the  report  pages  (PDF  or  docx),  and  manually  annotate  the
experiment.

What  is  the  minimum  version  of  Adobe  Acrobat  required  to  view  the  report
PDFs?

PDFs generated by LabTutor Server are saved as version 1.4 (Acrobat 5 or above),
which most common PDF viewers should be able  to  read. It is  recommended that
you always use the latest version of Adobe Reader available.

What is the minimum version of Microsoft Word required create docx files?

You  must  have  Microsoft  Word  2007  or  later  installed  on  LabTutor  Server  in
order to  be  able  to  create  docx  reports.  There  are  many  software  products  and
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services  that  students  can  use  to  view  and  edit  docx  files  (Microsoft  Office,
OpenOffice.org, Google Docs etc.)

Is it possible for a student to just see a relevant course?

Yes, there are a couple of ways you can do this with restricted courses.

How to assign an existing student to a restricted course: 

1. Log  in  to  LabTutor  Server  as  an  Administrator  or  Instructor  (must  be
assigned to that course)

2. Navigate to Student > Find and Edit

3. Search for that student and click Edit

4. Unrestricted  courses  will  be  listed  in  Course  list  for  that  student  and
restricted courses in Available courses

5. Double-click a restricted course, or highlight and click ^ Add ^ to  have  that
restricted course added to that student's course list, now able to be accessed
from their homepage.

How to assign a new student to a restricted course: 

1. Log  in  to  LabTutor  Server  as  an  Administrator  or  Instructor  (must  be
assigned to that course)

2. Go to Students > Add a Student.

3. Enter a unique student User Name.

4. Enter a unique User ID.

5. Enter the student’s Given name and Family name.

6. You can also enter an Email address if desired.

7. Click the Protected checkbox if necessary.

8. By default,  all  unrestricted  courses  are  displayed  in  this  student's  Course
list.  All  restricted  courses  will  be  listed  in  Available  courses  and  may  be
added  to  the  Course  list  by  selecting  and  clicking  ^  Add  ^,  or  double-
clicking. Courses  in the  Course  list will be  available  and  displayed  on  that
students home page.

9. Click Save.

The other approach is to navigate to a new or existing course  in the  Server Admin
pages, check the box Allow students to add this course with access code:, define  an
course access code and communicate this to relevant student(s). They are then able
to  add (assign) themselves  to  this  course  by logging in, clicking the  +  Add  course
button on the student home page and entering the relevant course access code.
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In  either  case,  the  result  will  be  that  the  restricted  course  becomes  visible  and
available on that student's home page.

How many client machines can access the server at any one time?

Our tests  indicate  that over 200 users  can simultaneously access  LabTutor Server.
However, this depends on the specification of the server and client computers, and
the  experiments  that  the  students  are  conducting.  In  general,  we  advise  that  a
computer  with  high  specifications  should  be  used  for  the  LabTutor  Server
computer.

Is  it  possible  to  start/review  an  experiment  in  Client  without  a  PowerLab
connected?

Yes - when LabTutor Online  is  activated, a  student can log in and start or edit an
experiment  on  any  computer  on  which  LabTutor  Client  is  installed,  so  long  as
LabTutor Client can connect to LabTutor Server.

LabTutor Client can be installed on any number of computers. No PowerLab  need 
be connected to the computer running LabTutor Client. In this case, licensing is  on 
a per-student basis - either Individual or Bulk Student licenses. Bulk student licenses 
may purchased along with LabTutor or at anytime from adinstruments.com/
downloads/student_licenses.php and Individual Student licenses may be purchased 
from an authorized reseller or education provider.  A Bulk license, once added to 
LabTutor Server, permits access for a certain number of students (e.g. 25, 50, or 100 
students). Bulk licenses expire after a certain period. A student can only log into 
LabTutor Client for the first time provided there is a Bulk or Individual Student 
license available.

Is it possible to use LabAuthor and LabTutor Server on the same computer?

Installing LabAuthor on the same computer as LabTutor Server is not a  supported
configuration.  LabAuthor and LabTutor Server share  common  components  and
having  both  installed  on  the  same  machine  could  lead  to  confusing  and
unpredictable behavior. 

Where are  the  student experiments saved by default on the  Server, and can  this
location be changed?

It  is  saved  to  the  ‘LabTutor  Server’  folder  on  the  computer  running  LabTutor
Server, this  location cannot be  changed. The  path to  this  data  folder  depends  on
the version of Windows you are running:

Server 2003: C:/Documents and Settings/All Users/Application Data/
ADInstruments/LabTutor Server

Windows  Vista  and  later:  C:/ProgramData/ADInstruments/LabTutor

http://www.adinstruments.com/downloads/student_licenses.php
http://www.adinstruments.com/downloads/student_licenses.php
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Server). 

Is it possible to simultaneously open two different experiments in LabAuthor to
edit or combine them?

No, LabAuthor does not allow users  to  open and edit more  than one  experiment
at once.

LabTutor Online is missing some images when viewing from an iPad. How can I
fix this?

This can be fixed by clearing your web  browser's  cache. For iOS Safari,  navigate  to
Settings > Safari > Clear Cookies and Data.

Can I use LabTutor Server with a wireless network?

Wireless  networks  are  not  supported  for  a  classroom  situation  because  of
potential  wireless  interference  and  the  bandwidth  required  when  sampling  data
from  the  PowerLab  using  multiple  client  computers.  A  1Gbps  wired  network
connection is recommended for optimal performance.

Students have just updated Client in the student pages,  why are  their PowerLabs
now not being recognized?

If  students' PowerLabs are  not being recognized by Client after  a  version  update,
have them log out, switch their PowerLab off and on, and then log back into Client.

Why does the next Learning Module component appear greyed out and is unable
to be accessed in the student's course page?

Each  Learning  Module  component  must  be  submitted  before  the  subsequent
component can be  accessed. Therefore, each component of  the  Learning Module
must contain a report page (LabAuthor) and have 'Display Submit button'  (Server
admin pages) configured for that particular course.
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